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ภาคผนวก ก 

คูมือการติดตั้งระบบ 
 

ในการพัฒนาระบบสารสนเทศของฟารมสุกร ภาควิชาเทคโนโลยีทางสัตว มหาวทิยาลัยแม
โจ ผูศึกษาไดใชเทคโนโลยี โปรแกรมและซอฟตแวรท่ีสําคัญในการพฒันาระบบโดยใช ระบบ
จัดการฐานขอมูลสุกรดวย ภาษา PHP   โปรแกรม จัดการฐานขอมูล SQL Server 2005 และเว็บ
เซิรฟเวอร IIS Windows Sever 2003 และไดติดต้ังระบบตางๆท่ีสําคัญดังนี ้

 
ก.1 การติดตัง้ IIS ในระบบ วินโดวส 2003 
 การติดต้ัง IIS  ใน Windows Sever 2003  มี 2 ชองทางดวยกัน คือ ติดต้ังผาน Start -> 
Control Panel--> Add or Remove Programs และ ติดต้ังผาน Start -> Administrative Tools -> 
Configure Your Server Wizard ในท่ีนี้ผูศึกษาใชวิธีติดต้ังโดยวิธีแรกดงันี้ 

- คลิกเลือกเมนู Start -> Control Panel -> Add or Remove Programs เพื่อเปดหนาตาง Add 
or Remove Programs จากนัน้ก็คลิกท่ีเมน ูAdd/Remove Windows Components หนาตาง 
Windows Components Wizard จะปรากฏข้ึนมาดังรูปท่ี ก.1 

  

 
 

รูปท่ี ก.1 หนาตาง Add or Remove Programs และหนาตาง Windows 
Components Wizard 
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- คลิกเลือกท่ี Application Server แลวคลิกปุม Details… เพื่อแสดงรายการคอมโพเนนต
ยอยตางๆในหนาตาง Application Server ออกมา ดังรูปท่ี ก.2 

 

 
 

รูปท่ี ก.2 คลิกเลือก Internet Informations Servers (IIS) 
 
- เลือกหัวขอ ท่ีคอมโพเนนต Internet Informations Services (IIS) ใหมีเคร่ืองหมายถูก ซ่ึง
จะทําใหคอมโพเนนต Enable network COM+ access เปดการทํางานข้ึนมาโดยอัตโนมัติ 
เพราะวา COM+ เปนสวนประกอบสําคัญท่ี IIS จําเปนตองใช 

คลิกท่ีปุม OK ปดหนาตาง Application Server และคลิกปุม Next ในหนาตาง Windows 
Components Wizard ตามรูปท่ี ก.1 การติดต้ัง ISS จะเร่ิมข้ึน ซ่ึงเราจะตองเตรียมแผนซีดีติดต้ัง 
Windows 2003 เอาไวดวย เพราะระหวางการติดต้ัง เคร่ืองจะถามหาแผน Windows 2003 เพื่อจะ
เรียกใชไฟลในแผนติดต้ัง เพื่อทําการติดต้ัง 
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ก.2 การกําหนดคาท่ีเว็บเซิรฟเวอร 
 โดยกําหนดผานการทํางานของ Internet Informations Servers (IIS) Manager 
 

 
 

รูปท่ี ก.3 การสราง Virtual Directory ท่ี เว็บเซิรฟเวอร 
 

 
 

รูปท่ี ก.4 การกําหนดช่ือเว็บอินทราเน็ต 
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รูปท่ี ก.5 การกําหนดท่ีอยูของไฟลในระบบ 
 

 
 

รูปท่ี ก.6 การกําหนด Permissions 
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รูปท่ี ก.7 การเสร็จส้ินการติดต้ังไฟลระบบท่ีเว็บเซิรฟเวอร 

 
ก.3 การสรางฐานขอมูลบนเซิรฟเวอร 
  

การสรางฐานขอมูลในการพัฒนาระบบสารสนเทศของฟารมสุกร ภาควิชาเทคโนโลยีทาง
สัตว มหาวิทยาลัยแมโจ นั้นผูศึกษาไดพัฒนาระบบฐานขอมูลดวยโปรแกรม SQL Server 2005 โดย
มีเคร่ืองมือท่ีใชในการบริหารจัดการระบบฐานขอมูลของ SQL Server 2005 จะใชผานเคร่ืองมือท่ี
เรียกวา SQL Server Management Studio มีข้ันตอนดังนี้ 

- คลิกท่ีเมนู Start จากนัน้เลือก All Programs เลือกรายการ Microsoft SQL server 2005 
คลิกท่ีโปรแกรม SQL Server Managements Studio จะเขาสูโปรแกรม ดังรูปท่ี ก.8 
จากนั้นปอน Login และ Password ท่ีกําหนดโดย SQL Server สําหรับช่ือ Loin ท่ีมีสิทธิ
สูงสุด จะมีช่ือวา SA สวนรหัสผานจะเปนรหัสผานท่ีกําหนดไวในตอนติดต้ัง SQL 
Server 2005  
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รูปท่ี ก.8 การติดตอเซิรฟเวอรเพื่อเขาสูหนาจอ SQL Server Managements Studio 
- หลังจากปอนช่ือ Login และ Password ใหคลิกปุม Connect ก็จะเขาสูหนาจอของ
โปรแกรม Microsoft SQL server 2005 ดังรูปท่ี ก.9  

 

 
 

รูปท่ี ก.9 หนาจอของโปรแกรม Microsoft SQL server 2005 
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รูปท่ี ก.10 หนาจอการสรางตารางฐานขอมูลดวยโปรแกรม Microsoft SQL          
server 2005 

 

 
 

รูปท่ี ก.11 หนาจอฐานขอมูล SwineFram ในโปรแกรม Microsoft SQL server 
2005 
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ก.4 การติดตัง้ PHP ใน Internet Information Services (IIS)  
เร่ิมตนดวยการเขาไปใน IIS Manager ท่ีโฟลเดอร Web Sites แลวเลือกคําส่ัง Properties 

เพื่อเปดหนาตาง Web Sites Properties จากน้ันจึงคลิกท่ีแท็บ Home Directory ดัง รูปท่ี ก.12 
 

 
 

รูปท่ี ก.12 หนา Web Sites Properties 
 
- เม่ือคลิกท่ีแท็บ Home Directory ก็จะเขาหนาจอ Application Configuration ดังรูปท่ี ก.13 
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รูปท่ี ก.13 คลิกปุม Add เพื่อจะเขาไปเพิ่มนามสกุล .php ให IIS รูจัก 
 
-  คลิกท่ีปุม Add เพื่อเปดหนาตาง Add/Edit Application Mapping ดังรูปท่ี ก.14 
 

 
 

รูปท่ี ก.14 ระบุไฟลท่ีจะใชในการรันไฟลท่ีมีนามสกุล .php 
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- กรอกช่ือไฟลและนามสกลุในชอง Executable และ Extention ดังรูปท่ี ก.14 จากนั้นจึง
คลิกปุม OK  

ก.3.1 การเพิ่มรายการใน Web Service Extentions เพื่อให IIS รูจัก 
 ข้ันตอไป จะตองเพ่ิมรายการใน Web Service Extentions เพื่อให IIS รูจักและเปด
ใหใชงานไฟลเว็บเพจท่ีมีนามสกุลเปน .php ได ใหคลิกท่ี Web Service Extentions ใน
เฟรมฝงซายของหนาตาง IIS Manager แลวคลิกท่ีล้ิงค Add a new Web Service 
Extentions… ดังรูปท่ี ก.15 
 

 
 

รูปท่ี ก.15 การเพิ่ม Extentions ใหมให IIS รูจัก 
- จากรูปท่ี ก.15 กรอกช่ืออะไรก็ไดเขาไปในชอง Extentions name แตควรใหส่ือ
ความหมายในท่ีนี้ผูศึกษากรอก PHP จากน้ันใหคลิกปุม Add.... จะมีหนาตาง Add file 
แสดงออกมาเพ่ือใหเลือกไฟลท่ีจะทําหนาท่ีรันไฟลนามสกุล .php ดังรูปที่ ก.16 ในกรณี
นี้ผูศึกษาเลือกไฟล D:\php\php5isapi.dll แลวคลิกปุม OK จะกลับมาท่ีหนาตาง New 
Web Service Extentions อีกคร้ัง ไฟลท่ีถูกเลือกไวจะปรากฏในชอง Required files ดังรูป
ท่ี ก.17 
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รูปท่ี ก.16 หนาตาง Add file 
 

 
  

รูปท่ี ก.17 หนาตาง New Web Service Extentions ท่ี Add file เสร็จแลว 
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- ข้ันสุดทายใหเติมเคร่ืองหมาย ถูก ท่ีออปช่ัน Set extention status to Allowed แลวคลิกปุม 
OK  Extention ใหมจะปรากฏในรายการของ Web Service Extentions ดังรูปท่ี ก.18 เปน
อันส้ินสุดการติดต้ัง PHP ใน Internet Information Services (IIS) 

 

 
 

รูปท่ี ก.18 รายการ Extention PHP ท่ี Add file เขาไปในรายการ 
 

ก.5 การแบ็กอัพ และรีสโตรขอมูล  
การแบ็กอัพ และการรีสโตรขอมูลใน SQL Server 2005 ซ่ึงนับเปนงานท่ีสําคัญมากสําหรับ

ผูท่ีทําหนาท่ีในการดูแลระบบฐานขอมูล เนื่องจากการแบ็กอัพนัน้จะชวยทําใหความเส่ียงในการ
สูญเสียขอมูลลดนอยลง เปนการเก็บขอมูลไวเพื่อชวยใหระบบสามารถคืนสภาพกลับมาได เม่ือเกิด
ความเสียหายบางอยางข้ึน เชน มีการแกไข หรือเพิ่มขอมูลท่ีผิดพลาดลงไปในฐานขอมูล หรือใน
สวนของระบบท้ังฮารดแวร และซอฟตแวรก็ตาม โอกาสท่ีจะเกดิขอผิดพลาดเชนนี ้ ก็เปนไปไดสูง
มากทีเดยีว ซ่ึงเราจะตองกําหนดวาจะแบ็กอัพขอมูลบอยขนาดไหน อาจจะเปนสัปดาหละคร้ัง หรือ
เดือนละคร้ัง ก็แลวแตความจําเปนของลักษณะงาน ในท่ีนีผู้ศึกษาไดมีข้ันตอนการแบ็กอัพ
ฐานขอมูลใน SQL Server 2005  ดังนี ้
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การใช Management Studio ในการสราง Backup Device ในข้ันตอนตอไปนี ้
1. ใหเราคลิกเมาสปุมขวาท่ี Server Object > Backup Devices และเลือก New Backup 

Device… ดังรูปท่ี ก.19 
 

 
 

รูปท่ี ก.19 การสราง Backup Device 
  
2. จะปรากฏหนาตางใหเรากําหนดช่ือ และช่ือไฟลท่ีจะใชในการแบ็กอัพ (ถาเซิรฟเวอร

ของเรามีเทปแบ็กอัพ ก็สามารถท่ีจะเลือกในสวน Destination เปนตัวเลือก Tape ได) เม่ือเราเลือก
เสร็จแลว ใหคลิกเมาสปุม OK ดังรูปท่ี ก.20 
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 รูปท่ี ก.20 การกําหนดช่ือ และช่ือไฟลท่ีจะใชในการแบ็กอัพ 
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ภาคผนวก ข 

คูมือการใชงานระบบ  
 

 ระบบสารสนเทศของฟารมสุกร ภาควิชาเทคโนโลยีทางสัตว มหาวิทยาลัยแมโจ เปนระบบ
การจัดการฐานขอมูลเกี่ยวกบัฟารมสุกร ในลักษณะขอมูลของสุกร โดยใชงานผานระบบเครือขาย
และใชโปรแกรมไมโครซอฟทเอ็กพลอรเลอร 5 ข้ึนไป ในท่ีนี้โปรแกรมแบงออกเปน 4 สวนคือ 

1. สวนของผูดูแลระบบ 
2. สวนของงานบันทึกขอมูลสุกร 
3. สวนของการออกรายงาน 
4. สวนของการชวยเหลือการใชงาน     
ผูใชงานสามารถเขาใชงานผานระบบเครือขายไดท่ี 
http://animal.mju.ac.th/pigfarm.index จะปรากฏหนาแรกของระบบดังรูปท่ี ข.1 
 

  
 

รูปท่ี ข.1 หนาแรกระบบสารสนเทศของฟารมสุกรภาควิชาเทคโนโลยีทางสัตว
มหาวิทยาลัยแมโจ 
จากรูปท่ี ข.1 หนาแรกของระบบเปนสวนสําหรับการล็อกอินเขาใชงานในระบบ

สารสนเทศของฟารมสุกรภาควิชาเทคโนโลยีทางสัตวมหาวิทยาลัยแมโจ โดยใสช่ือผูใชและ
รหัสผานใหถูกตอง สามารถเขาใชไดเฉพาะผูท่ีมี Username กับ Password เทานั้น แลวเลือกปุม เขา
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สูระบบ ถาปอน ช่ือผูใช หรือ รหัสผานไมถูกตอง ระบบจะแจงเตือน “ทานปอนขอมูลไมถูกตอง” 
และจะเขาใชงานในระบบไมได ดังรูปท่ี ข.2 และ ถาผูใชปอนช่ือผูใช และรหัสผานถูกตอง ระบบ
จะเขาสูสวนของการทํางานในระบบดังรูปท่ี ข.3 

 

 
 
รูปท่ี ข.2  แจงเตือนการ ปอนขอมูลเขาใชไมถูกตอง 
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รูปท่ี ข.3  หนาแรกของการเขาสูการใชงานระบบ 
 

เม่ือเขาสูหนาแรกของการเขาใชระบบแลวจะมีเมนูท่ีหนาจอใหเลือกเพ่ือทําหนาท่ีในแตละ
สวนของระบบตามสิทธิของผูเขาใชงาน ซ่ึงจะมีอยู 2 ระดับ คือสิทธิของผูใชท่ัวไป กับสิทธิของ
ผูดูแลระบบ 

- สิทธิของผูใชท่ัวไป จะมีสิทธิท่ีเขาใชทํางานไดเฉพาะสวนของการบันทึกขอมูลสุกรกับ
สวนของการออกรายงานเทานั้นไมมีสิทธิท่ีจะเขาไปแกไขขอมูลในสวนของผูดูแลระบบ
ได 

-  สิทธิของผูดูแลระบบ จะมีสิทธิในการเขาใชทํางานไดในทุกๆสวนของระบบรวมถึงการ
เขาไปเพิ่มเติม แกไขในสวนของระบบขอมูลพื้นฐานของระบบฐานขอมูล 

ดังจะแสดงการใชงานในสวนตางๆของระบบตอไปนี ้
 
ข.1 สวนของผูดูแลระบบ 
 เม่ือผูใชเลือกเมนูสวนของผูดูแลระบบกจ็ะเขาสูหนาจอระบบเพิ่ม-แกไขขอมูลพื้นฐาน ดัง
แสดงในรูปท่ี ข.4 และ จะมีเมนใูหเลือกเขาไปจัดการกับขอมูลพื้นฐานในระบบฐานขอมูลดังนี้ 
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รูปท่ี ข.4  หนาจอเขาใชงานสวนของผูดูแลระบบ 
 

 ข.1.1 ถาเลือกเมนูขอมูลของผูใชระบบ  
หนาจอจะแสดงรายช่ือและรายละเอียดขอมูลของผูมีสิทธิท่ีจะสามารถล็อกอินเขา

มาใชงานในระบบฐานขอมูลได ดังแสดงในรูปท่ี ข.5 ซ่ึงผูใชแตละคนจะถูกกําหนด ช่ือ
ผูใช รหัสผานและสิทธิของการเขาใชในระบบของโปรแกรมไดจากหนาจอเมนูนี้ ใน
หนาจอนี้สามารถเพิ่ม ลบ และแกไขขอมูลผูใชไดทุกคนแลวแตจะเห็นสมควรจากหัวหนา
หนวยงานหรือผูบังคับบัญชา ดังแสดงในรูปท่ี ข.6 ซ่ึงจะตองปอนขอมูลผูใชท่ีจะเพิ่มเขาไป
ใหครบทุกชอง พรอมกําหนด ช่ือผูใชงาน รหัสผาน และสิทธิของการเขาใชงานในระบบ 
แลวคลิก บันทึกขอมูล ระบบก็จะเพิ่มผูใชงานในระบบใหและพรอมท่ีจะใหผูเขาใชงาน
ใหมเขาใชงานในระบบโดยการล็อกอินเขาระบบดวย ช่ือผูใช และ รหัสผานตามท่ีถูก
กําหนดไว พรอมสิทธิของการเขาใชงาน แนนอนสามรถเพ่ิมไดก็สามรถลบผูใชงานหรือ
ยกเลิกผูใชงานไมใหเขาสูการเขาใชงานในระบบได โดยคลิกท่ี ลบ ซายมือของรายการ
แสดงช่ือผูเขาใชงาน และจะลบอยางถาวร ถาจะกลับเขามาใชงานอีกก็ใหเพิ่มรายการขอมูล
ใหมเขาไปในระบบอีกคร้ัง 
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  รูปท่ี ข.5  ขอมูลของผูมีสิทธิเขาใชงาน 
 

 
 

รูปท่ี ข.6  การเพิ่มรายการขอมูลผูเขาใชงาน 
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รูปท่ี ข.7  หนาจอแกไขรายการขอมูลของผูเขาใชงาน 
 จากรูปท่ี ข.7 แสดงหนาจอแกไขรายการขอมูลของผูเขาใชงานระบบ สามารถเขาแกไข
รายละเอียดของผูใชงานไดท้ังหมดแกไขแลวบันทึกกเ็ปนอันเสร็จส้ินการแกไขรายการขอมูล 
 
 ข.1.2 เลือกเมนูสถานะสุกร 

แสดงรายละเอียดขอมูลสถานะสุกรท้ังหมด ดังรูปท่ี ข.8 ซ่ึงก็จะมีรายการ เพิ่ม
ขอมูลใหมเขาไปในระบบ และแกไขขอมูลในระบบไดเทานั้นดังรูปท่ี ข.9 และรูปท่ี ข.10 
ไมสามารถลบขอมูลออกจากระบบฐานขอมูลไดอันมีผลตอการทํางานผิดพลาดของ
โปรแกรมระบบฐานขอมูลโดยรวมได ดังเชน ถาจะเพ่ิมสถานะสุกร สุกรหนุมเขาไปก็ให
คลิกท่ี เพิ่มขอมูลใหม ขวามือในตารางแสดงรายละเอียด หรือจะแกไขสถานะสุกร จาก
สุกรเล็กเปนสุกรอนุบาล ก็ใหคลิก แกไข ท่ีขวามือในตารางตรงกับชองแสดงสถานะสุกร
เล็กนั้น เสร็จแลวก็ทําการบันทึกทุกคร้ัง เพื่อใหมีผลตอการใชงานในระบบตอไป 
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รูปท่ี ข.8  รายละเอียดสถานะสุกรในระบบ 
 

 
 

รูปท่ี ข.9  เพิ่มรายการสถานะสุกร 
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รูปท่ี ข.10  แกไขรายการสถานะสุกร 
 
 ข.1.3 เลือกเมนูแหลงท่ีมาสุกร 

แสดงรายละเอียดขอมูลแหลงท่ีมาสุกร ดังรูปท่ี ข.11 ซ่ึงก็จะมีรายการ เพิ่มขอมูล
ใหมเขาไปในระบบ และแกไขขอมูลในระบบไดเทานั้นดังรูปท่ี ข.12 และรูปท่ี ข.13 ไม
สามารถลบขอมูลออกจากระบบฐานขอมูลไดอันมีผลตอการทํางานผิดพลาดของโปรแกรม
ระบบฐานขอมูลโดยรวมได ดังเชน ถาจะเพ่ิมแหลงท่ีมาสุกร เขาไปก็ใหคลิกท่ี เพิ่มขอมูล
ใหม ขวามือในตารางแสดงรายละเอียด หรือจะแกไขแหลงท่ีมาสุกร ก็ใหคลิก แกไข ท่ี
ขวามือในตารางตรงกับชองแสดงแหลงท่ีมาสุกรนั้นๆ เสร็จแลวก็ทําการบันทึกทุกคร้ัง 
เพื่อใหมีผลตอการใชงานในระบบตอไป 
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รูปท่ี ข.11  รายละเอียดแหลงท่ีมาสุกร 
 

 
 

รูปท่ี ข.12  เพิ่มรายการแหลงท่ีมาสุกร 
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รูปท่ี ข.13 แกไขรายการแหลงท่ีมาสุกร 
 
 ข.1.4 เลือกเมนูสายพันธุสุกร 

แสดงรายละเอียดขอมูลสายพันธุสุกร ดังรูปท่ี ข.14 ซ่ึงก็จะมีรายการ เพิ่มขอมูล
ใหมเขาไปในระบบ และแกไขขอมูลในระบบไดเทานั้นดังรูปท่ี ข.15 และรูปท่ี ข.16 ไม
สามารถลบขอมูลออกจากระบบฐานขอมูลไดอันมีผลตอการทํางานผิดพลาดของโปรแกรม
ระบบฐานขอมูลโดยรวมได ดังเชน ถาจะเพิ่มสายพันธุสุกร เขาไปก็ใหคลิกท่ี เพิ่มขอมูล
ใหม ขวามือในตารางแสดงรายละเอียด หรือจะแกไขสายพันธุสุกร ก็ใหคลิก แกไข ท่ี
ขวามือในตารางตรงกับชองแสดงสายพันธุสุกรนั้นๆ เสร็จแลวก็ทําการบันทึกทุกคร้ัง 
เพื่อใหมีผลตอการใชงานในระบบตอไป 
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รูปท่ี ข.14  รายละเอียดสายพันธุสุกร 
 

 
 

รูปท่ี ข.15  เพิ่มรายการสายพันธุสุกร 
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รูปท่ี ข.16  แกไขรายการสายพันธุสุกร 
  
ข.1.5 เลือกเมนูวัคซีนท่ีใชในสุกร 

แสดงรายละเอียดขอมูลวัคซีนท่ีใชในสุกร ดังรูปท่ี ข.17 ซ่ึงก็จะมีรายการ เพิ่มขอมูลใหม
เขาไปในระบบ และแกไขขอมูลในระบบไดเทานั้นดังรูปท่ี ข.18 และรูปท่ี ข.19ไมสามารถลบ
ขอมูลออกจากระบบฐานขอมูลไดอันมีผลตอการทํางานผิดพลาดของโปรแกรมระบบฐานขอมูล
โดยรวมได ดังเชน ถาจะเพิ่มวัคซีนท่ีใชในสุกร เขาไปก็ใหคลิกท่ี เพิ่มขอมูลใหม ขวามือในตาราง
แสดงรายละเอียด หรือจะแกไขวัคซีนท่ีใชในสุกร ก็ใหคลิก แกไข ท่ีขวามือในตารางตรงกับชอง
แสดงวัคซีนท่ีใชในสุกรนั้นๆ เสร็จแลวก็ทําการบันทึกทุกคร้ัง เพื่อใหมีผลตอการใชงานในระบบ
ตอไป 
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รูปท่ี ข.17  รายละเอียดวัคซีนท่ีใชในสุกร 
 

 
 

รูปท่ี ข.18  เพิ่มรายการยาหรือวัคซีน 
 
 



 70

 
 

รูปท่ี ข.19  แกไขยาหรือวัคซีนท่ีใช  
 

ข.1.6 เลือกเมนูเหตุการณสุกร 
แสดงรายละเอียดขอมูลเหตุการณสุกร ดังรูปท่ี ข.20 ซ่ึงก็จะมีรายการ เพิ่มขอมูล

ใหมเขาไปในระบบ และแกไขขอมูลในระบบไดเทานั้นดังรูปท่ี ข.21 และรูปท่ี ข.22 ไม
สามารถลบขอมูลออกจากระบบฐานขอมูลไดอันมีผลตอการทํางานผิดพลาดของโปรแกรม
ระบบฐานขอมูลโดยรวมได ดังเชน ถาจะเพ่ิมเหตุการณสุกร เขาไปก็ใหคลิกท่ี เพิ่มขอมูล
ใหม ขวามือในตารางแสดงรายละเอียด หรือจะแกไขเหตุการณสุกร ก็ใหคลิก แกไข ท่ี
ขวามือในตารางตรงกับชองแสดงเหตุการณสุกรนั้นๆ เสร็จแลวก็ทําการบันทึกทุกคร้ัง 
เพื่อใหมีผลตอการใชงานในระบบตอไป 
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รูปท่ี ข.20  รายละเอียดเหตุการณสุกร 
 

 
 

รูปท่ี ข.21  เพิ่มรายการเหตุการณสุกร 
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รูปท่ี ข.22  แกไขรายการเหตุการณสุกร 
 

ข.1.7 เลือกเมนูโรคสุกร 
แสดงรายละเอียดขอมูลโรคสุกร ดังรูปท่ี ข.23 ซ่ึงก็จะมีรายการ เพิ่มขอมูลใหมเขา

ไปในระบบ และแกไขขอมูลในระบบไดเทานั้นดังรูปท่ี ข.24 และรูปท่ี ข.25ไมสามารถลบ
ขอมูลออกจากระบบฐานขอมูลไดอันมีผลตอการทํางานผิดพลาดของโปรแกรมระบบ
ฐานขอมูลโดยรวมได ดังเชน ถาจะเพิ่มโรคสุกร เขาไปก็ใหคลิกท่ี เพิ่มขอมูลใหม ขวามือ
ในตารางแสดงรายละเอียด หรือจะแกไขโรคสุกร ก็ใหคลิก แกไข ท่ีขวามือในตารางตรง
กับชองแสดงโรคสุกรนั้นๆ เสร็จแลวก็ทําการบันทึกทุกคร้ัง เพื่อใหมีผลตอการใชงานใน
ระบบตอไป 
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รูปท่ี ข.23  รายละเอียดโรคสุกร 
 

 
 

รูปท่ี ข.24  เพิ่มรายการโรคสุกร 
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รูปท่ี ข.25  แกไขรายการโรคสุกร 
 

ข.1.8 เลือกเมนูสาเหตุการตาย 
แสดงรายละเอียดขอมูลสาเหตุการตายสุกรดังรูปท่ี ข.26 ซ่ึงก็จะมีรายการ เพิ่ม

ขอมูลใหมเขาไปในระบบ และแกไขขอมูลในระบบไดเทานั้นดังรูปท่ี ข.27 และรูปท่ี ข.28
ไมสามารถลบขอมูลออกจากระบบฐานขอมูลไดอันมีผลตอการทํางานผิดพลาดของ
โปรแกรมระบบฐานขอมูลโดยรวมได ดังเชน ถาจะเพ่ิมสาเหตุการตายสุกรเขาไปก็ใหคลิก
ท่ี เพิ่มขอมูลใหม ขวามือในตารางแสดงรายละเอียด หรือจะแกไขสาเหตุการตายสุกรก็ให
คลิก แกไข ท่ีขวามือในตารางตรงกับชองแสดงสาเหตุการตายสุกรนั้นๆ เสร็จแลวก็ทําการ
บันทึกทุกคร้ัง เพื่อใหมีผลตอการใชงานในระบบตอไป 
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รูปท่ี ข.26  รายละเอียดสาเหตุการตายสุกร 
 
 

 
 

รูปท่ี ข.27  เพิ่มรายการสาเหตุการตายของสุกร 
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รูปท่ี ข.28  แกไขรายการสาเหตุการตายสุกร 
  
 จากเมนูผูดูแลระบบจะมีผูเขามาใชงานแกไข เพิ่มรายการไดตองเปนผูใชในระดับ Admin 
ท่ีถูกกําหนดไวในระบบขอมูลพื้นฐานระบบฐานขอมูล เทานั้น เสร็จจากทํารายการตางในระบบ
ผูดูแลระบบแลว ใหทําการคลิก เมนู ออกจากระบบ มุมบนดานขวาของโปรแกรมเพ่ือเขาสูหนาจอ
เมนูหลักในการเขาใชงานสวนอ่ืนของระบบตอไป 
 
ข.2 สวนของงานบันทึกขอมูลสุกร 
 เม่ือผูใชเลือกเมนูสวนของงานบันทึกขอมูลสุกรก็จะเขาสูหนาจอระบบบันทึกขอมูลสุกร 
ดังแสดงในรูปท่ี ข.29 และ จะมีเมนใูหเลือกเขาไปจดัการกับขอมูลพื้นฐานในระบบฐานขอมูลดังนี ้
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รูปท่ี ข.29  หนาจอเขาสูระบบบันทึกขอมูลสุกร 
  

ข.2.1 เลือกเมนูเปดบันทึกขอมูลสุกร 
  แสดงฟอรมเปดบันทึกขอมูลสุกร ดังรูปท่ี ข.30  
 

 
 

รูปท่ี ข.30  ฟอรมเปดบันทึกขอมูลสุกร 



 78

จากฟอรมเปดบันทึกขอมูลสุกรเปนฟอรมท่ีใชเก็บขอมูลสุกรท่ีอยูในฟารมเองหรือ
นํามาจากท่ีอ่ืนแลวนํามาเล้ียงในฟารมเพื่อเล้ียงขายหรือขุนเปนพอแมพนัธุจะมีชองใหปอน
ขอมูลดังนี้ 

- เบอรหู เปนสวนขอมูลพืน้ฐานของสุกรต้ังแตแรกเกดิ จะถูกติดรหัสประจําตัว
สุกรเสมอใหปอนรหัสนี้ในชองเบอรหู 

- วันท่ีเกิด เปนวันเดือนป ท่ีสุกรคลอดจากแม  
- เบอรแม เปนรหัสประจําตัวสุกรท่ีเปนแมของตัวมันเอง 
- เบอรพอ เปนรหัสประจําตัวสุกรท่ีนํามาผสมกับแมพันธุของตัวมันเอง 
- วนัท่ียายเขา เปนวนัเดือนป ท่ีไดนําสุกรเขามาเล้ียงในฟารม หรือเกิดท่ีฟารมเอง

ตองปอนขอมูลขอมูลนี้ทุกตัว 
- สายพันธุ เปนสายพันธุสุกรท่ีนําเขามาเล้ียงในฟารมหรือผสมเองจากฟารมถาเปน

ลูกสุกรผสมมาสามสายพันธุแลวจะเลือก-ไมระบุ- 
- เตานมซาย เตานมขวา เปนจํานวนเตานมของตัวสุกรเองต้ังแตแรกเกิด  
- แหลงท่ีมา เปนแหลงท่ีสุกรเกิดท่ีอ่ืนไมใชในฟารมเราเองแลวนําเขามาเล้ียง 
- เพศ ระบุเพศสุกรตัวผูหรือตัวเมีย 
- ครอก-คร้ังท่ีทอง ระบุจํานวนลําดับท่ีทองของแมพันธุ ตอนเกิด 
- สถานะ ระบุสถานะสุกรตอนท่ีนําเขาระบบฐานขอมูล คือสุกรท่ีนําเขามาหรือเกิด
ท่ีฟารมเอง เปนสุกรอยูในสถานะไหนเชน พอพันธุ แมพนัธุ หรือสุกรแรกเกิด 

- น้ําหนัก ปอนขอมูลน้ําหนักสุกรนะวันท่ีเกิด นําเขาฟารม และชวงท่ีเปล่ียน
สถานะ 

- สาเหตุการตาย จะระบุสุกรแรกเกดิตอนท่ีแรกคลอด 
- การเกดิโรค จะระบุสุกรแรกเกิดตอนท่ีแรกคลอด 
- หมายเหตุ จะระบุประกอบไดจากการสังเกตตัวสุกร ท่ีผิดปกติหรือผูดูแลให
ขอมูลเพิ่มเติม 

สังเกตถาปอนขอมูลท่ีสําคัญไมครบ ฟอรมเปดบันทึกขอมูลจะแจงเตือนดังรูปท่ี ข.31 
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รูปท่ี ข.31  ฟอรมเปดบันทึกขอมูลสุกรท่ีปอนขอมูลไมครบ 
 

ข.2.2 เลือกเมนูบันทึกขอมูลการผสมพันธุสุกร 
แสดงฟอรมเปดบันทึกขอมูลผสมพันธุสุกร ดังรูปท่ี ข.32 

 

 
 
รูปท่ี ข.32  ฟอรมบันทึกการผสมพันธุสุกร 
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จากฟอรมบันทึกการผสมพันธุสุกร จะแสดงขอมูลแมพันธุ และพอพันธุข้ึนมาให
ระบุ วันเดือนปท่ี ผสมพันธุ แลวเลือกเบอรแมพันธุ พอพนัธุท่ีจับคูกันผสมพันธุ 
  

ข.2.3 เลือกเมนูบันทึกการตรวจสัด 
 แสดงฟอรมบันทึกการตรวจสัดสุกร ดังรูปท่ี ข.33 

 
 

 
 

รูปท่ี ข.33  การเลือกเขาสูฟอรมการตรวจสัดสุกร 
 
จากฟอรมบันทึกการตรวจสัด ใหเลือกเดือนปท่ีมีการผสมพันธุสุกรแลวตองการ

ตรวจสัดสุกร แลวเลือกแสดงขอมูล ระบบจะแสดงขอมูลสุกรท่ีมีการผสมพันธุในเดือนนั้น
ออกมาแลวเลือกตารางที่จะตรวจสัดวาจะตรวจสัดสุกรในระยะไหนตามลําดับ ถาระยะ
ไหนมีการบันทึกการตรวจสัดไปแลวจะแสดงขอมูลการตรวจข้ึนมาดังรูปท่ี ข.36 ถาให
ปอนขอมูลก็แสดงวายังไมมีการตรวจสัด ซ่ึงแตละชวงของการตรวจสัดก็จะมีฟอรมข้ึนมา
ใหปอนขอมูลดังรูปท่ี ข.34 และรูปท่ี ข.35 
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รูปท่ี ข.34  ฟอรมบันทึกการตรวจสัดสุกร 21 วัน 

 

 
 

รูปท่ี ข.35  ฟอรมบันทึกการตรวจสัดสุกร42  
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รูปท่ี ข.36  ตารางบันทึกขอมูลการตรวจสัดสุกร 
 

ข.2.3 เลือกเมนูบันทึกการปรับสถานะสุกร 
 แสดงฟอรมบันทึกการตรวจสัดสุกร ดังรูปท่ี ข.37 ใหเลือกสถานะสุกรท่ีจะปรับ

สถานะข้ึนมา คลิกปุมแสดงขอมูล ก็จะมีรายการสุกรแสดงข้ึนมาใหเลือกปรับสถานะดังรูปท่ี ข.38 
ใหเลือกเบอรสุกรท่ีถึงเวลาปรับสถานะ จากรุนสูอีกรุน แลวคลิก ปรับสถานะสุกร เขาสูการปอน
ขอมูลสถานะใหมใหสุกรท่ีเราเลือก ดังรูปท่ี ข.39โดยจะมีขอมูลน้ําหนักสุกร ในชวงท่ีเปล่ียน
สถานะ และระบุสถานะท่ีจะเปล่ียนไปของสุกร แลวคลิกปุม บันทึกขอมูลสุกร 
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รูปท่ี ข.37  หนาจอเลือกแสดงขอมูลเพื่อปรับสถานะสุกร 
 

 
 
รูปท่ี ข.38  หนาจอแสดงขอมูลเพื่อเลือกปรับสถานะสุกร 
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รูปท่ี ข.39  ฟอรมการบันทึกการปรับสถานะสุกร 
 

ข.2.5 เลือกเมนูบันทึกเหตุการณสุกร 
แสดงฟอรมบันทึกเหตุการณสุกร ดังรูปท่ี ข.40 ใหปอนรหัสสุกรแลวคลิกปุม

ตรวจสอบขอมูล ระบบจะทําการตรวจสอบขอมูลสุกรตามรหัสท่ีปอนในระบบฐานขอมูลวามีสุกร
ท่ีปอนรหัสเพื่อบันทึกเหตุการณนั้นมีอยูในฐานขอมูลหรือไม ถาไมมีจะถูกแจงเตือนใหทราบถามีก็
จะเขาฟอรมบันทึกเหตุการณสุกรในรหัสสุกรท่ีปอนนั้นดังรูปท่ี ข.41 
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รูปท่ี ข.40  หนาจอตรวจสอบขอมูลเพื่อเขาสูการบันทึกขอมูลเหตุการณ 

 

 
 

รูปท่ี ข.41  ฟอรมบันทึกการเกิดเหตุการณสุกร 
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จากฟอรมบันทึกเหตุการณสุกรท่ีตรวจสอบแลววามีตัวตน ก็จะเขาสูระบบบันทึก
ขอมูลเหตุการณท่ีเกิดกับสุกรนั้น โดยระบุ วันเดือนป ท่ีเกิดเหตุการณ แลวเลือกเหตุการณท่ีเกิดกับ
สุกร อธิบายขอมูลเพิ่มเติมในชองหมายเหตุ แลวเลือกบันทึก เพื่อบันทึกขอมูลลงในระบบ 

 
ข.2.6 เลือกเมนูบันทึกการทําวัคซีนสุกร 

แสดงฟอรมบันทึกการทําวัคซีนสุกร ดังรูปท่ี ข.42 ใหเลือก วันเดือนปท่ีทําวัคซีน 
แลวเลือกวัคซีนท่ีจะทําในชองชนิดวัคซีน ระบุกลุมสุกรท่ีจะทําวัคซีน อธิบายเหตุผล แลวคลิกปุม
บันทึก ระบบจะแสดงกลุมสุกรท่ีเลือกจะทําวัคซีนข้ึนดงัรูปท่ี ข.43 

 

 
 

รูปท่ี ข.42  หนาจอฟอรมบันทึกการทําวัคซีน 
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รูปท่ี ข.43  หนาจอเลือกขอมูลท่ีบันทึกการทําวัคซีน 
 จากการแสดงขอมูลกลุมสุกรท่ีจะทําวัคซีน ใหเลือกสุกรตามรหัส ท่ีตองการทําวัคซีนแลว
ทําการบันทึกขอมูล เสร็จส้ินการบันทึกการทําวัคซีน 
 

ข.2.7 เลือกเมนูบันทึกการเกิดโรคในสุกร 
แสดงฟอรมบันทึกการเกิดโรคในสุกร ดังรูปท่ี ข.44 ใหปอนรหัสสุกรแลวคลิกปุม

ตรวจสอบขอมูล ระบบจะทําการตรวจสอบขอมูลสุกรตามรหัสท่ีปอนในระบบฐานขอมูลวามีสุกร
ท่ีปอนรหัสเพื่อบันทึกเหตุการณนั้นมีอยูในฐานขอมูลหรือไม ถาไมมีจะถูกแจงเตือนใหทราบถามีก็
จะเขาฟอรมบันทึกการเกิดโรคในสุกรรหัสท่ีปอนนั้นดังรูปท่ี ข.45 
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รูปท่ี ข.44  การตรวจสอบขอมูลเพื่อเขาสูการบันทึก 
 

 
 

รูปท่ี ข.45  หนาจอฟอรมบันทึกการเกิดโรคในสุกร 
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จากฟอรมบันทึกเหตุการณสุกรท่ีตรวจสอบแลววามีตัวตน ก็จะเขาสูระบบบันทึกขอมูล
เหตุการณท่ีเกิดกับสุกรนั้น โดยระบุ วันเดือนป ท่ีเจอสุกรเกิดโรค แลวเลือกชนิดของอาการโรคท่ี
เกิดกับสุกร อธิบายขอมูลเพิ่มเติมในชองหมายเหตุ แลวเลือกบันทึก เพื่อบันทึกขอมูลลงในระบบ 

เสร็จจากทํารายการตางๆในระบบการบันทึกขอมูลแลว ใหทําการคลิก เมนู ออกจากระบบ 
มุมบนดานขวาของโปรแกรมเพื่อเขาสูหนาจอเมนูหลักในการเขาใชงานสวนอ่ืนของระบบตอไป 

 
ข.3 สวนของการออกรายงานขอมูลสุกร 

  เม่ือผูใชเลือกเมนูสวนของการออกรายงานขอมูลสุกรก็จะเขาสูหนาจอระบบ
รายงานขอมูลสุกร ดังแสดงในรูปท่ี ข.46 และ จะมีเมนูใหเลือกเขาไปจัดการกับการรายงานใน
ระบบฐานขอมูลดังนี้ 
 

 
 

รูปท่ี ข.46  หนาจอเขาสูสวนของการออกรายงานขอมูลสุกร 
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ข.3.1 เลือกเมนูสรุปรายงานฟารม 
แสดงรายงานสรุปขอมูลสุกร ดังรูปท่ี ข.47 จะเปนการออกรายงานขอมูลสุกร

ประจําเดือน ใหเลือก เดือนป ท่ีจะใหออกรายงาน แลวคลิกปุมรายงาน ระบบก็จะแสดงรายงานสรุป
ประจําเดือนใหดังตารางในรูปท่ี ข.48 ถาตองการรายงานพิมพเปนเอกสารก็ใหเลือกเมนู File > Print 
ในเมนู Internet Explorer เพื่อพิมพรายงาน ทางเคร่ืองพิมพ 
 

 
 

รูปท่ี ข.47  การเลือกออกรายงาน 
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รูปท่ี ข.48  การออกรายงาน สรุปรายงานฟารมสุกรทางเคร่ืองพิมพ 
 

ข.3.2 เลือกเมนูรายงานประวัติสุกร 
เขาสูหนาจอแสดงการตรวจสอบสุกรออกรายงานประวัติสุกรดังรูปท่ี ข.49 ให

ปอนรหัสสุกรแลวคลิกปุมตรวจสอบขอมูล ระบบจะทําการตรวจสอบขอมูลสุกรตามรหัสท่ีปอนใน
ระบบฐานขอมูลวามีสุกรท่ีปอนรหัสเพื่อขอดูประวัตินั้นมีอยูในฐานขอมูลหรือไม ถาไมมีจะถูกแจง
เตือนใหทราบถามีก็จะเขาหนาจอแสดงประวัติสุกรจากรหัสสุกรท่ีตองการทราบประวัตินั้นดังรูปท่ี 
ข.50 และถาสุกรมีรหัสซํ้ากันก็จะแสดงออกมาท้ังหมด ท้ังนี้สุกรบางฟารมอาจมีรหัสท่ีเหมือนกัน 
แตจะมีสถานะท่ีตางกันอยู ถาตองการรายงานพิมพเปนเอกสารก็ใหเลือกเมนู File > Print ในเมนู 
Internet Explorer เพื่อพิมพรายงาน ทางเคร่ืองพิมพ 
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รูปท่ี ข.49  การตรวจสอบสุกรออกรายงานประวัติสุกร 
 

 
 

รูปท่ี ข.50  การออกรายงานประวัติสุกรทางเคร่ืองพิมพ 
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ข.3.3 เลือกเมนูรายงานประวัติสุกร 
แสดงหนาจอใหเลือกชวงของ วันเดือนป ท่ีผสมสุกรดังรูปท่ี ข.51 แลว คลิก ปุม

รายงาน ระบบจะแสดงขอมูลการผสมพันธุในเดือนนั้น ดังรูปท่ี ข.52 ถาตองการรายงานพิมพเปน
เอกสารก็ใหเลือกเมนู File > Print ในเมนู Internet Explorer เพื่อพิมพรายงาน ทางเคร่ืองพิมพ 
 

 
 

รูปท่ี ข.51  หนาจอการเลือกออกรายงานการผสมพันธุสุกร 
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รูปท่ี ข.52  การออกรายงานขอมูลการผสมพันธุสุกรทางเคร่ืองพิมพ 
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ข.3.4 เลือกเมนูรายงานการคลอดสุกร 
แสดงหนาจอใหเลือกชวงของ วันเดือนป ท่ีสุกรคลอกหรือเกิด ดังรูปท่ี ข.53 แลว 

คลิก ปุมรายงาน ระบบจะแสดงขอมูลการคลอดของสุกรในชวงเดือนนั้น ดังรูปท่ี ข.54 ถาตองการ
รายงานพิมพเปนเอกสารก็ใหเลือกเมนู File > Print ในเมนู Internet Explorer เพื่อพิมพรายงาน ทาง
เคร่ืองพิมพ 

 
 
 

 
 

รูปท่ี ข.53  หนาจอการเลือกออกรายงานการคลอดของสุกร 
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รูปท่ี ข.54  การออกรายงานการคลอดของสุกรทางเคร่ืองพิมพ 
 

ข.3.5 เลือกเมนูรายงานการหยานมสุกร 
แสดงหนาจอใหเลือก เดือนป ท่ีสุกรแรกเกิดหยานมจากแมแลวกินอาหาร ดังรูปท่ี 

ข.55 นั่นคือการเปล่ียนสถานะสุกรจากสุกรนมไปเปนสุกรเล็กหรือสุกรอนุบาลแลว คลิก ปุม
รายงาน ระบบจะแสดงขอมูลสุกรที่หยานมในชวงเดือนนั้น ดังรูปท่ี ข.56 ถาตองการรายงานพิมพ
เปนเอกสารก็ให เลือกเมนู File > Print ในเมนู Internet Explorer เพื่อพิมพรายงาน ทางเคร่ืองพิมพ 
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  รูปท่ี ข.55  หนาจอการเลือกออกรายงานการหยานม 
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  รูปท่ี ข.56  การออกรายงานการหยานมของลูกสุกรทางเคร่ืองพิมพ 
 

ข.3.6 เลือกเมนูรายงานการเกิดโรคสุกร 
แสดงหนาจอใหเลือก เดือนป ท่ีตองการขอมูล ดังรูปท่ี ข.57 แลว คลิก ปุมรายงาน 

ระบบจะแสดงขอมูลสุกรท่ีเกิดโรคในชวงเดือนนั้น ในตารางดังรูปท่ี ข.58 ถาตองการรายงานพิมพ
เปนเอกสารก็ให เลือกเมนู File > Print ในเมนู Internet Explorer เพื่อพิมพรายงาน ทางเคร่ืองพิมพ 
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รูปท่ี ข.57  รายงานการรักษาและการเกิดโรคสุกร 
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รูปท่ี ข.58  รายงานการรักษาและการเกิดโรคสุกรทางเคร่ืองพิมพ 
 

ข.3.7 เลือกเมนูประสิทธิภาพการผสมพนัธุ 
แสดงหนาจอใหปอนรหัสแมพันธุสุกร ดังรูปท่ี ข.59 แลว คลิก ปุมรายงาน ระบบ

จะแสดงขอมูลแมพันธุสุกร ขอมูลการผสม การคลอดจริง การกําหนดวันคลอดท่ีไดผสมพันธุ และ
สถานการณผสม วาทองหรือไม หรือกลับสัด หรือเกิดลูกแลวแทง ในตารางดังรูปท่ี ข.60 ถา
ตองการรายงานพิมพเปนเอกสารก็ให เลือกเมนู File > Print ในเมนู Internet Explorer เพื่อพิมพ
รายงาน ทางเคร่ืองพิมพ 
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รูปท่ี ข.59  การออกรายงานประสิทธิภาพการผสมพันธุสุกร 
 

 
 
รูปท่ี ข.60  การออกรายงานประสิทธิภาพการผสมพันธุสุกรทางเคร่ืองพิมพ 
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ข.3.8 เลือกเมนูประสิทธิภาพการผสมพนัธุ 
แสดงหนาจอใหปอนรหัสแมพันธุสุกร ดังรูปท่ี ข.61แลว คลิก ปุมรายงาน ระบบ

จะแสดงขอมูลแมพันธุสุกร ขอมูลการเกิดลูก น้ําหนักลูกแรกเกิด น้ําหนักลูกตอนหยานม เปนตน 
ในตารางดังรูปท่ี ข.62 ถาตองการรายงานพิมพเปนเอกสารก็ให เลือกเมนู File > Print ในเมนู 
Internet Explorer เพื่อพิมพรายงาน ทางเคร่ืองพิมพ 

 
 

 
 

รูปท่ี ข.61  การออกรายงานประสิทธิภาพการผลิตลูกสุกร 
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รูปท่ี ข.62  การออกรายงานประสิทธิภาพการผลิตลูกสุกรทางเคร่ืองพิมพ 
 
เสร็จจากทํารายการตางๆในระบบการออกรายงานขอมูลแลว ใหทําการคลิก เมนู 

ออกจากระบบ มุมบนดานขวาของโปรแกรมเพื่อเขาสูหนาจอเมนูหลักในการเขาใชงานสวนอ่ืนของ
ระบบตอไป 

 
ข.4 สวนของการชวยเหลือการใชงาน     

ทุกหนาจอของระบบจะมีปุม ชวยเหลือ หรือ ปุม ตองการความชวยเหลือ ถาผูใช
ไมเขาใจในการเขาใชงานในสวนตางๆของระบบสามารถคลิกอานคูมือการใชงานไดในตัว
ชวยเหลือเหลานี้ 

* หมายเหตุ : ทุกคร้ังท่ีผูใชงานเขาสูการใชงานในระบบแลวเสร็จส้ินการใชงาน
ในระบบใหยกเลิกการเขาใชระบบ โดยคลิกปุม ออกจากระบบ จาก หนาจอเมนูหลักทุกคร้ังใหหนา
จอแสดงผลออกจากระบบไปสูหนาท่ีล็อกอินเขาระบบเหมือนตอนแรก ดังรูป ข.63 เพื่อความ
ปลอดภัยตอขอมูลในระบบ 
 



 104

 
 

รูปท่ี ข.63  หนาจอออกจากระบบสูหนาล็อกอินเขาระบบ 
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